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Desktop:
Whenever your PC is running, the desktop is always there.  It may be hidden behind 
something else, but in the background it's always there.  The desktop consists of three 
main parts: the background, the taskbar, and a number of icons.  We'll examine each of 
these items individually.

Background:
The background may be simple — a plain colour — or may be painted with a more 
elaborate picture (called wallpaper).  On a new PC the background often has the 
manufacturer's logo, but it can be anything.  You can change the visual appearance of 
the background in the Control Panel (more on that later).

Taskbar:

The taskbar (shown above with a Classic appearance and below with an Aero theme) 
appears along one edge of your screen.  (On a new PC it is usually along the bottom; you 
can move it to a different edge by dragging it there, although you may have to unlock it 
first.) Depending on your settings, the taskbar may always be fully visible, or it may 
reduce itself to a thin line (called autohide) until you move the mouse pointer to that 
edge of the screen.  Either way, though, it's always there, as long as Windows is running. 
(A console-mode application can cover up the taskbar, but this is increasingly rare.)

The taskbar hosts three main things: the Start menu, a list of all your open 
windows, and the system tray.  We'll talk about the Start menu soon, as well 
as opening windows.  The system tray is the part at the right with that handy 
clock in it, which also shows the date.

Desktop Icons:
Your desktop may be home to any 
number of icons.  (Several typical 
examples are shown at left.) These are 
usually shortcuts to various programs, 
document files, and folders.  (A folder 
is like a container, a storage location 
on your computer's disk, where 
documents and other files can be stored.)

Double-clicking an icon on the desktop will typically open a window; the 
exact nature of the window it will open depends on the shortcut.  The "My 
Computer" icon will open a window showing the various disks and drives in 
your computer.  The "Recycle Bin" icon will open a window listing things 
you've thrown away recently.  A folder icon may open a folder window, which 
will contain icons for each of the things stored in that folder.  Technically 

speaking, each icon generally represents a file, or a shortcut to a file.  (Technically, 
folders and shortcuts are special kinds of files, because they are stored on your 

Tip: If the desktop isn't visible,  
you can minimize whatever  
windows are covering it up,  
and it will become visible  

again. The windows you minimize  
will still be there in the taskbar,  
waiting for you to click and restore  
them to their former positions.
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computer's disk drive just like all the other files.)

By dragging an icon from one place to another, you can move or copy the file (or 
shortcut, or folder) from one location (folder or disk) to another.  Double-clicking an 
icon will usually open the file associated with that icon (assuming your computer knows 
how to open that kind of file; the details of how such associations work are beyond the 
scope of this class).

Start Menu:
We said earlier that the taskbar hosts the start menu. 
Normally the start menu will be hidden in that little 
button (the Windows logo), but if you click that, the 
whole menu pops out.  The start menu contains the 
Control Panel, which will let you customise the system 
more to your liking, as well as the All Programs 
submenu (which contains shortcuts, similar to the 
icons on your desktop) and a number of other helpful 
items.  Advanced users can customise some of the 
content of this menu, but some things (like the search 
box) are just always there.  If you move your mouse 
onto the Start menu to All Programs and either click 
there or just wait a couple of seconds, you'll see that 
the menu expands (or changes) to list shortcuts to your 
various applications, as well as some subcategories.

Windows:
Now we come to the main 
thing that makes Windows 
what it is: the actual 
windows themselves.

A typical window is shown 
to the right, with several of 
the major parts labeled. 
The window's title (if it has 
one) is displayed in the title  
bar, at the top.  You can 
reposition a window by 
dragging the title bar 
around the screen.  If you 
click on the maximize 
button, the window will 
expand to take up more (or 
all) of the screen.  (Click the 
same button again, and it 
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should restore to its former size.) The minimize button will reduce the window to the 
taskbar.  You won't see it on the screen, except in the taskbar, but it is still open, and if 
you click its taskbar entry it comes back to the front.  Clicking on the close button is a 
more drastic measure that you can use when you're totally finished with the window to 
make it go away entirely. Almost all windows (except for a few very simple or special 
ones) have these things in common.  

The window in the screenshot also has a menubar (more on these in a moment), a 
couple of toolbars (below the menubar), a status bar (which gives additional 
information), and scrollbars (for displaying what doesn't fit in the window at first). 
Many windows have these components.

Menubars:
Many windows have a menu bar, just below the title bar. 
Each word or phrase on the menu bar will, if clicked, 
pull down and expand into a menu — a list of various 
commands and/or submenus.  Here you can see that we 
have pulled down the Organize menu for this window. 
The first menu on the left (usually called File, but in this 
case Organize) is generally where you open and save 
documents (known to your computer as files).  The 
menu on the right is usually the Help menu.  There is 
usually an About entry in the Help menu, which will tell 

you what 
application the 
window belongs 
to, and what 
version of that 
application you 
have.  There will 
be other menus in 
between File and 
Help, which will vary from one kind of window to 
another.  In many cases the second menu will be 
the Edit menu; if so, there will probably be Cut, 
Copy, and Paste commands there, and possibly 
Undo.  (The Hands On Documents class covers 
these editing commands in greater detail.)

Below the menubar there may be one or more toolbars, which contain shortcuts for 
some of the more common things you might want to do with the application.  Toolbars 
vary greatly from one application to another.  Often the toolbars do not have room for 
all of an application's functionality, so they typically only have some of the most 
common things; the rest will be in the menus.

Tip: Some programs,  
like Internet Explorer,  
do have a menubar but 
keep it hidden unless  

you turn it on.  If you right-
click on the toolbar there's  
usually a checkbox to show it.

Tip: Some menu entries have 
shortcut keys listed to the  
right.  If you get tired of  
pulling a menu down for the  

same command all the time, you 
can learn the keyboard shortcut  
and save yourself a few seconds  
each time – which can really add 
up for things you do frequently. 
For example, if the Save command 
has the shortcut Ctrl-S, you can 
hold Ctrl and press S, and presto,  
your document is saved, without  
reaching for the File menu.  



Galion Public Library Page 4 Hands On Windows Seven

Using Applications:
Any application that is installed on your computer  has 
usually put a shortcut icon for itself on either your desktop 
or your start menu (under All Programs) — often both 
places. You can start the application by clicking its entry in 

the start menu or by double-
clicking its shortcut icon on the 
desktop. (There are numerous 
other ways to start an 
application, but these two are 
easy to learn.)

In Windows Seven, you can also 
pin an application shortcut to 
the start menu or to the task list. 
Right-click the shortcut and find 
the Pin to option on the context 
menu.  If you change your mind 
later you can right-click again 
and unpin them.

Changing Settings:
In the start menu, you'll find the 
control panel.  Here's where you can 
change a number of settings that 
impact how your whole computer 
operates. 

For example, the Appearances and Personalization section of the control panel will let 
you change your desktop's background, your screen saver settings, and the colors that 
all your applications use. Fooling around in 
the settings, you can swap your mouse 
buttons, set your computer to play funny 
sounds when you open and close windows, 
increase the resolution (so you can see more 
things at once), decrease the resolution (so 
things are larger, so you don't have to squint), 
change the date and time on your computer's 
clock, and so on. Some of these settings are 
actually useful, and others are merely 
amusing. (A few can even be risky: stay away 
from Add New Hardware unless you really 



Galion Public Library Page 5 Hands On Windows Seven

have new hardware to install.)  You can also add things to (and remove things from) the 
Start Menu — look in the Taskbar settings.

Accessories:
There are a number of really common things that people do with computers: type up 
stuff to print out on paper, browse the world wide web, paint or draw pictures, and so 
on. For the things you do most, you'll probably want to download or purchase an 
application designed for those things, but if you only do something once in a while, you 
may find a simple app that will get you by, already installed on your system. Windows 
comes with a number of very simple apps: a calculator, a word processor (WordPad), a 
text editor (Notepad), a drawing program (Paint), and so on. Many of these can be found 
in the Accessories folder (under All Programs in the Start Menu). Once again, these are 
very rudimentary applications, without many features, a dim shadow of the much better 
applications that are available for download or for purchase. But the Accessories will 
often get you by in a pinch if you need to do some small thing and haven't installed a 
good application for doing it yet.
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Advanced Mouse Operations:
Ever get the feeling that you should be able to do 
something else here, but you don't see an option for it? 
Try the right mouse button, and see what new options 
appear. For example, in your web browser, right-clicking 
may let you save a copy of that picture, or open that link 
in a separate tab. 

When you drag a file from one window to another with 
the left button, you usually move it, but if you right-drag, 

you get options to 
move it, copy it, or 
create a shortcut link 
to it.  This may seem 
overwhelming now, 
but remember that 
right button: when 
you're ready to go 
beyond the basics, 
you'll be glad it's 
there.

Another advanced mouse operation is multi-select, 
accomplished by ctrl-clicking or shift-clicking. Many 
situations that require you to select an item from a list 
(or an icon from a window full of them) will allow you 
to select more than one. If you hold Ctrl while clicking, 
you can leave the already-selected one(s) selected, 
while selecting an additional one. That is, click the 
first one, then hold Ctrl while clicking each of the 
others, and you can select several. Shift-clicking is 
similar, but instead of selecting individual items it 
selects a range. If you click the first item, then hold 
shift while clicking the last item, you will have selected 
all the items in between as well.  In some software this 
same trick even works for selecting multiple sections 
of text at once, by holding Crtl while dragging.
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Microsoft Windows Versions
Year(s)

DOS-
based

NT-based

for desktops servers

1994-1997 Windows 
95

Windows NT 3.5

1998-1999
Windows 

98
Windows NT 4.0 Workstation

NT4 
Server

2000-2001
Windows 

Me
Windows 2000 Professional

Windows 
2000 
Server

2001-2003

[no more 
versions]

Windows XP 
Home Edition

Windows XP Professional
Windows 

Server 
2003

2007-2008

Windows 
Vista 
Home 
Basic

Windows 
Vista 
Home 

Premium

Windows 
Vista 

Business

Windows 
Vista 

Enterprise

Windows 
Vista 

Ultimate

Windows 
Server 
2008

2009-2010

Windows 
Seven 
Home 
Basic

Windows 
Seven 
Home 

Premium

Windows 
Seven 

Profes-
sional

Windows 
Seven 

Enterprise

Windows 
Seven 

Ultimate

Windows 
Server 

2008 R2

TBA ? ? ? ? ? ?

In the first column of the chart you see the years that each product was released.

In the second column you see the DOS-based product line (95, 98, Me) that most home 
users had in the late nineties.  This product was discontinued around the turn of the 
century, mostly because it wasn't really designed with networks and security in mind.

Everything in the remaining columns is Windows NT, the product we usually call 
"Microsoft Windows" today.  It has become more "differentiated" over the years.

Starting with NT4, Microsoft split off the "server" product (far right column), which is 
intended to be used on computers that provide network services to other computers, 
from the main (desktop/workstation) product, which is used on computers people 
actually sit in front of and use directly.  

Starting with Windows XP, the desktop/workstation line was further split:  the 
professional/business versions (right) support Active Directory networking and are 
mainly aimed at businesses; the home versions (left) are intended for home computers, 
which generally do not connect to an Active Directory business network.

A more detailed history is available upon request as a separate handout.



Galion Public Library Page 8 Hands On Windows Seven

File Management
File management in Windows is normally done using 
the Windows Explorer file manager that comes with 
Windows.  You can open a Windows Explorer window 
by launching the My Computer or My Documents 
shortcut, or by specifically looking for Windows 
Explorer in the Accessories.  

Your desktop is also managed by Windows Explorer, 
along with any icons on it.  In fact, you can treat the desktop as a special Explorer window.

Windows Explorer can show you the contents of your computer's hard drive (or any disk) in 
various ways, but we will start by looking at a basic icon view similar to your desktop.  Double-
click on the My Documents shortcut on your desktop.  This should open a window containing 
some icons, just like your desktop.  Each icon represents a file or a folder, or a shortcut to a file 
or a folder.  (A folder is a special type of file that can contain other files.  Folders are sometimes 

called directories.)  A file is some kind of 
stored information, such as a text file, a 
picture, a configuration file, a program, or 
whatever.  A shortcut is just a link to some 
other location where a file is really stored. 
Icons that represent shortcuts have a little 
arrow over their lower-left corner.  Icons 
that represent folders look like filing folders. 
Other icons represent various kinds of files.

You can open any file by double-clicking it, if 
Windows Explorer knows how to open that 

kind of file.  It knows how to open folders, of course, but many applications also install 
something called associations that tell Windows Explorer how to open various kinds of files with 
them.  Consequently, almost any file you've saved you can just doubleclick in Windows Explorer 
to open it, rather than having to go through the application you used to create the file.  The 
application will start automatically and open the file.

Your computer contains a lot of files – files that make Windows and various applications work, 
plus anything you or any of your software has saved.  All of this is stored somewhere on your 
computer's hard drive.

Most likely the files you're interested in are the ones you've created, which will be wherever you 
put them – usually in the My Documents folder (although it's possible to put them in other 
places, such as an external hard drive or other storage device).  

One problem a lot of people encounter is that the My Documents folder tends to accumulate a 
lot of files, so that it becomes difficult to locate a specific one.  When this happens, it's time to 
learn to manage your files – that is, to organize them.

Tip: Windows Explorer is not  
the same as Internet Explorer.

There are visual similarities,  
but they are not the same.  Internet  
Explorer is for browsing the web,  
but Windows Explorer (explorer.exe)  
is for managing files.



Galion Public Library Page 9 Hands On Windows Seven

One of the most useful features for managing files is 
the folder.  You can create as many folders as you like 
and sort your files into them.  For example, you can 
put all of your pictures into one folder, so that they 
don't clutter up your My Documents folder. 
Windows Seven provides a special Library folder just 
for this, called My Pictures.  You can drag your 
picture files into this folder and store them all in that 
one place together.  Grab a file and drag it over a 
folder.  When the folder is highlighted, let go.  The 
file will be moved to that folder.  If the folder is on a 
different disk, like a floppy disk, then the file will be 
copied instead of moved.  Also, if the file is executable1, 
then a shortcut will be created.  Any time you want to 
choose between these behaviors, you can drag with the 
right button instead of the left, and when you let go 
you can pick between the three options.  

Sometimes you want more folders than are already 
present.  For example, you may have different kinds of pictures and want to categorize them – 
family pictures in one folder, for example, and nature photographs in another.  

You can create a new folder within a 
given  folder window by right-clicking 
the background area of the window 
and choosing New Folder.  You can 
name the folder anything you like.  (If 
you don't give it a name, it will have a 
default name like "New Folder".)  If 
you later change your mind about the 
name, right-click the folder and 
choose Rename.  

You can create as many folders as you like this way – folders within folders within folders.  Open 
your My Pictures folder and create a Family Pictures folder, for all your family pictures.  Then 
open that folder and create another folder inside it for pictures of Uncle Eustace or 
Aunt Mehetabel or whomever.  If you have a digital camera and have taken dozens of pictures of 
a particular relative, you may want to create folders inside their folder for different years or 
events, so that you can keep all the pictures straight.

If you have two Explorer windows open side-by-side, you can drag files from one to the other, 
and they will be copied or moved.  (If you right-drag them, you can choose whether to copy, 
move, or create a shortcut.)  The desktop is a special Explorer window, so you can drag files to 
and from it just like any other.

1 An executable file is an application or utility or some other program, instructions for the computer. 
Unlike a regular data file such as a text or a picture, an executable file does something when opened.
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Explorer also has other ways to display 
a folder's contents, besides just the icon 
view.  Under the View menu you can 
switch between Filmstrip, Thumbnails, 
Tiles, Icons, List, and Details.  Details 
lets you see things like when a file was 
last modified.  You can also sort the 
Details view by a column, by clicking on 
the column name at the top of the list.

The Explorer windows we have looked at so far have 
been single-pane views.  Explorer also has a two-
pane tree view (sometimes called explore view) that 
is useful for looking at your directory hierarchy 
(that is, folders inside of folders inside of folders) at 
a glance.

Right-click on any folder and choose Explore.  You 
should see something like the window shown.  The 
window has two panes: a left one containing folders, 
and a right one for showing the contents of a folder.

Next to each drive or folder in the left pane there is a 
little plus or minus thing (called an expansion 
widget) that can be used to show or hide the 
subfolder contents of that container.  If you click on 
the plus, it shows the contents.  If you click on the 
minus, it hides them.  In the window shown, you see 
that the Documents and Settings folder is expanded, 
so the folders within are shown underneath.  (Each 
level is indented slightly.)

The next several folders (All Users, Default User, etc.
) are not expanded, but the folder called root is 
expanded, and within it the folder called 
My Documents is expanded.  You can see that 
My Documents contains four folders (instruction, 
My Music, My Pictures, and My Videos).  One of 
these is highlighted.  The highlighted folder is the 
one that is selected.  You can select any folder by 
clicking on it, and its contents will be shown in the 
pane to the right.  In this case, the contents of the 
instruction folder are shown at right – two files:  a 
shortcut to an images folder, and a document with a 
name that starts with "intermediat".

A file can be dragged from the pane on the right onto 
any folder in the left pane tree view, and the file will 
be moved to that folder.
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Software Installation
Installing software in Windows varies a little from one 
software package to another, but it's not as tricky as a 
lot of people seem to expect.

Most software comes packaged in an automatic 
installer program that does most of the work for you. 
Usually, you download the installer by clicking a link 
in your web browser, saving the installer to your 
computer someplace (the desktop is as good a place as 
any).  After the download finishes you doubleclick on 
the installer icon, which typically asks you to agree to 
a license agreement, click "Next" a couple of times, 
answer a handful of easy questions, and it's done. 
Sometimes it'll ask you to reboot afterward.

Sometimes the installer will come packaged inside a 
.ZIP file2.  Recent versions of Windows can 
automatically open this as a "Compressed Folder".

Installing OpenOffice is fairly typical.  You unzip 
the .ZIP file, which contains a number of files inside it. 
One of them is called setup.  You double-click on this, 
and (as of version 1.1) click Next twice, scroll down the 
license agreement, check "I Accept", click Next again, 
optionally fill out your name and stuff, click Next three 
more times, click Yes, click Install, click Ok twice, wait a minute for the progress bar, click Yes if 
it asks you to replace a file, wait a minute again, and click the Complete button.  

That may sound like a lot of questions it's asking you, but the answer is always "Yes" or "Next". 
The times when you have to click other buttons (like "Ok" or "Install" or "Complete"), it's the 
only button available.

Software that comes packaged in a self-extracting executable installer package, like Mozilla, is 
even easier.  Often, the hardest part is waiting a few minutes for the download to complete.

Uninstalling
Most software that you install gives instructions to Windows for how to uninstall it 
automatically.  Windows keeps track of this information for you.  When you want to uninstall 
some software, you go to your control panel, choose Add or Remove Programs, select the 
program you want to uninstall from the list, and click the Remove button.  Sometimes the 
uninstaller will ask you a couple of questions, like whether you want to delete the program's 
files.

2 ZIP is a special type of file that contains other files.  Websites that are distributing multiple files 
together will often package them as a ZIP file.  Windows will call it a "Compressed Folder".

Tip:  If you are looking for  
software to install, you may 
like the following:

OpenOffice.org offers a suite of office  
applications for word processing,  
presentations, spreadsheets, etc.

www.pmail.com offers the Pegasus  
Mail reader, a convenient and 
featureful way to read your email.

www.mozilla.org distributes an 
excellent web browser.

corefonts.sourceforge.net has the  
Core Fonts that Microsoft used to  
have at their typography site.  These  
are some of the nicest-looking fonts  
you will find anywhere.

http://gimp-win.sourceforge.net/  
offers the Gimp Image Manipulation  
Program, for editing photos and 
other images.
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Command Prompt
If there's one feature of Windows that frightens newbies the most, it's probably the command 
prompt (sometimes called the "MS-DOS Prompt" or simply "DOS", after an older operating 
system that used a command prompt interface exclusively).  It's not really something to be 
afraid of, but it is true that the command prompt is a more advanced feature, and so it takes 
more effort to learn to use it really effectively.  It's flexible, and advanced users can do quite a lot 
of stuff with it.   Also, in an emergency, Windows can often be started in command prompt mode 
in order to fix problems, even if the rest of Windows is unable to finish starting.

We're not going to cover the command prompt in detail here, just enough of the basics 
to get by in a pinch.  At the command prompt, you type a command and hit the Enter 
key.  The command then does something and displays some kind of answer or result.

Probably the most useful command for a beginner is the help command, which displays a list of 
the other commands.  Each command also has its own built-in help.  To get help on a specific 
command, type the name of the command followed by a space and /?  

For example, to get help on the dir command, type dir /? and press Enter.  The response will 
say that this command "displays a list of files and subdirectories in a directory".  (Remember 
that directory is another term for folder – a special kind of file that contains other files.  The 
command prompt always uses the term directory.)  To look at files and directories on a different 
drive, type the drive letter followed by a colon and press Enter.  For example, you might type C: 
to look at the main hard drive or A: to look at a floppy disk.

In addition to the built-in commands, you can use any program that's installed on the computer 
as a command.  The command prompt will find the program and run it if it is in the current 
directory (or in one of several special directories listed in the PATH environment variable).

When Things Go Wrong...
If Windows starts acting up, the first thing you want to try to 
clear things up is to shut it down and restart the computer.  It 
continually amazes me how many problems crop up in 
Windows that can be solved just by restarting the computer.

Process Management

Sometimes, however, you don't need to restart the whole 
computer.  Sometimes you don't want to restart the whole 
computer, because you're in the middle of something. 
Sometimes you only need to restart one application that has 
stopped responding.  This is where the Windows Task 
Manager comes in.  You can invoke the Task Manager by 
holding the Ctrl and Alt keys on your keyboard and tapping 
the Del or Delete key.  The Task Manager allows you to select a 
certain application (presumably, one that's giving you trouble) 
and stop it (by pressing the End Task button).  (In Windows 
95, 98, or Me you may have to do this several times to get the problem task really stopped.)  
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Housecleaning

Sometimes a piece of software decides it ought to run all the time, even when you're not using it. 
Maybe it's software you really do use sometimes, like instant messaging software, but it slows 
your computer down even when you're not using it.  Maybe it's some adware or spyware that 
isn't useful itself but came bundled with some other software you installed.  If it starts up when 
your computer starts, and you don't want it to, you can stop it, by removing its entry from the 
registry run keys.  Tools like Ad-Aware are available that can do this automatically for some 
software, or if you are brave you can do it manually with regedit.  (An extra page of handout is 
available on this topic.  Ask me.)

Associations
It is possible to change the associations that determine which 
program is used to open each type of file.  For example, text files 
ending with the .txt extension always open in Notepad when you 
doubleclick them.  You can change this.

In an Explorer window, pull down the Tools menu and choose 
Folder Options (or just Options in some versions).  Explorer has a 
number of settings you can change.  Under the General tab you 
can choose between classic folders or the newer view with the 
common tasks on the side.  Under the View tab you can change 
things like whether "hidden" files are shown and whether the 
extension (like .txt) on the end of filenames is shown or hidden. 
Under the File Types tab is where you can change associations. 
You will see a long list of file types.  Scroll down to the one you 

want (say, Text Document) and click the Change or Edit button (or, if you want to get into 
details, the Advanced button).  This will allow you to change what application is used to open 
files of this type.
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Editing the Registry
Windows stores a lot of settings in your registry – how 
your computer starts up, how various applications 
behave, even how Internet Explorer identifies itself to 
websites you visit.  Before you make any changes to 
the registry, you should always export a backup of its 
current state.  If something goes wrong, it is possible 
to restore the registry from this backup.

Once you've exported a backup, look around a bit, just 
to get a feel for how much information is stored in the 
registry.  It's a lot of stuff!

Some of the registry keys that are most useful to know 
about are the Run keys.  Applications that are listed in 
these keys are automatically started by Windows when 
the computer is turned on.

There are two major Run keys in the registry. 
One is under HKEY_CURRENT_USER and the 
other is under HKEY_LOCAL_MACHINE. 
Under each of these keys, look for a Software 
key, and under Software find Microsoft, and 
under Microsoft find Windows, and under 
Windows find Current Version.  There you 
should find a Run key.  Click it, and the right 
pane will show the values associated with that 
key.  Each value lists a program or command 
that is run each 
time Windows 
starts up.  If 
you right click 
any of these, 
choose Modify, 
erase the value 
data, and hit 

Ok, Windows will no longer start that program when it starts 
up.  Restart Windows to see the difference.

If you change your mind or something goes wrong, restore the 
registry to its former state by merging the backup you created 
before you made the change.  Then restart Windows, and all 
should be as it was.

Many of the keys in the registry are obscure or technical in 
nature, but occasionally you will find tips on the web explaining 
how to change the behavior of Windows in some fashion by 
editing certain registry keys.  For example: 
http://www.codeproject.com/system/modifyregistry.asp

Tip: Always export a backup 
of the registry before making 
changes.

• Click the Start button, click Run, type 
regedit and press Enter.  This starts 
the registry editor.

• Pull down the File menu and choose 
Export.

• Under Export Range, make sure that 
All is selected (not Current Branch).

• For File Name, type in something like 
C:\backup1.reg or C:\backup2.reg

Click the Save button.

Tip: Use the merge 
feature of regedit to  
restore your registry 
from a backup that 

you exported earlier.

• Click the Start button, click 
Run, type regedit and 
press Enter.  This starts the 
registry editor.

• Pull down the File menu 
and choose Import.

• Under File Name, type in 
the same thing you typed 
when exporting your 
backup, such as 
C:\backup1.reg

Click the Open button.


